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C H A P T E R  1 0

Personalizing Ubuntu: 
Getting Everything Just Right

If you’ve read this book from Chapter 1, by this stage you no doubt have become comfort-

able with Ubuntu. You’ve started to realize its advantages and are on the way to making it 

your operating system of choice.

But things might still not be quite right. For instance, you might find the color scheme 

is not to your taste. Or perhaps the mouse cursor moves a little too fast (or too slowly). 

Maybe you simply want to stamp your individuality on your system to make it your very 

own. That’s what this chapter is all about. We look at personalizing Ubuntu, so that you’re 

completely happy with your user experience. To do this, we will thoroughly examine the 

GNOME desktop and explore its potential.

Changing the Look and Feel
Ubuntu is similar to Windows in many ways, but the developers behind it introduced 

improvements and tweaks that many claim make the software easier to use. For example, 

Ubuntu offers multiple virtual desktops—long considered a very useful user-interface 

feature that seems to have passed by Microsoft. 

■Note  The virtual desktop feature also passed by Apple for a long time. However, it was recently included 

in OS X Leopard, in the form of Spaces. 

The Ubuntu desktop also moves the programs menu to the top of the screen, leaving 

the whole width of the screen at the bottom to display taskbar buttons. This is very sensible, 

because the buttons don’t look cramped when more than a handful of applications are 

open. However, if you’re not satisfied with Ubuntu’s out-of-the-box look and feel, you can 

change it.
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You might be used to changing the desktop colors or wallpaper under Windows, but 

Ubuntu goes to extremes and lets you alter the look and feel of the entire desktop. Every-

thing from the styling of the program windows to the desktop icons can be altered quickly 

and easily. 

Altering the Theme

Ubuntu refers to the look of the desktop as a theme. Because it’s built on the GNOME 

desktop, Ubuntu allows you to radically personalize your desktop theme. Several different 

themes come with the distribution, and you can download many more. Each lets you 

change the way the windows look, including the buttons and the icon set (although some 

themes come without additional icons).

However, unlike Windows themes, GNOME themes don’t usually change the fonts 

used on the desktop, and the wallpaper will probably remain broadly the same. You can 

change these manually, as described in the “Setting Font Preferences” and “Changing the 

Wallpaper” sections a bit later in this chapter.

To alter the theme, select System ➤ Preferences ➤ Appearance. Then it’s simply a 

matter of choosing a theme from the list on the Theme tab in the Appearance Preferences 

dialog box, as shown in Figure 10-1. A useful hint is to open a Nautilus file browser window 

in the background (Places ➤ Home Folder), so you can see how the changes will affect a 

typical window.

■Note  The default Ubuntu theme is called Human and is designed to represent the skin tones of the world’s 

population. This is intended to reflect Ubuntu’s mission of being accessible to everyone, no matter where or 

who they are. In fact, there are three variations of the theme available in the Appearance Preferences dialog 

box: Human, Human Clearlooks, and Human Murrine. All vary the design very slightly. Try them to see which 

you like best!

Our favorite themes are Clearlooks and Mist, largely because they’re simple and uncom-

plicated. Remember that you’ll be working with the theme on a daily basis, so it should be 

practical and not too distracting. Those miniature close, minimize, and maximize buttons 

might look stylish, but they’re useless if they’re so small that you can’t reliably click them 

with your mouse.
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As well as changing the overall theme, you can also modify individual theme compo-

nents and even download more theme components. 

Figure 10-1. Ubuntu comes with several theme choices.

Changing Individual Theme Components

You can alter the five aspects that constitute a GNOME theme: the controls (sometimes 

known as widgets), color scheme, window borders, icons, and mouse pointer. To make 

changes to a theme, select it on the Theme tab of the Appearance Preferences dialog box 

(see Figure 10-1), and then click the Customize button. You will see the Customize Theme 

dialog box, as shown in Figure 10-2. Click each tab to see your choices:
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Figure 10-2. You can customize a theme by choosing your own controls, colors, window 

border, icons, and mouse pointer.

Controls: These are the elements you click within dialog boxes and windows: buttons, 

scroll bars, check boxes, radio buttons, and so on. The chief difference between one 

set of controls and another relates to their 3D effect—some are inset against the back-

ground, and some appear to be prominent. Some controls are shiny, and some appear 

flat. Additionally, some are rounded, and some are square. Rounded controls somehow 

feel more friendly; squared controls tend to feel more businesslike. 

Colors: You can set the background and text color of windows, input boxes, selected 

items, and tooltips. However, note that controls nearly always come with their own 

color schemes, which override any changes you make to color settings. A few controls 

not only override color settings, but also do not support tweakable color schemes. 

Examples include the High Contrast Inverse and High Contrast Large Print Inverse 

controls.

Window Border: The options on this tab control the borders of program windows and 

dialog boxes. Particular attention is paid to the top of the window, where the program 

name appears along with the minimize, maximize, and close buttons.
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Icons: This tab lets you control which icon set is in use. An icon set includes icons for 

everything you see on the screen or in menus, including folders, the Trash, programs, 

hard disks, network servers, and so on. Selecting a new icon set will change all icons. 

■Note   The Icons tab of the Customize Themes dialog box doesn’t let you change the icons for specific 

desktop items. This can be done by right-clicking the icon, selecting Properties from the menu that appears, 

and then clicking the icon preview button at the top left of the dialog box. Note that most stock icons are 

stored in /usr/share/icons. Any icons you change individually in this way won’t be affected by changes 

made to the icon set. 

Pointer: On this tab, you can set the appearance of the mouse pointer. Aside from the 

pointer’s design, you can change its size (although this is not supported on all mouse 

pointers) by adjusting the Size slider. A larger mouse pointer might help the visually 

impaired. A small mouse pointer would be appropriate for low-resolution or small 

screens like those on ultraportable laptops. 

You will see thumbnail previews of each style. As soon as you click each option, it will 

be applied automatically to the currently open windows. To preview the effects fully, the 

best policy is to keep a Nautilus window open (Places ➤ Home Folder).

When you’ve made your choices, you can save the theme for further use. Click Close in 

the Customize Theme dialog box, and then click the Save As button in the Theme tab of 

the Appearance Preferences dialog box. You’ll need to give the theme a name and, if you 

wish, a short description for future reference. By putting a check in the Save Background 

Image box, the theme will also remember the wallpaper that’s in use. Once saved, the 

theme will be available for selection from the Theme tab, where the themes are listed in 

alphabetical order. If you checked Save Background Image, when you select the theme in 

the future, the wallpaper will be suggested at the bottom of the Theme tab. To select it, 

just click the Apply Background button.

If you don’t save the theme, as soon as you select another one, the changes you made 

will be lost.

Installing Additional Components

If you get tired of the built-in possibilities, you can download additional theme components, 

such as window borders and controls, to enhance your desktop experience. Two popular 

web sites (among others) that you can visit are GNOME Art (http://art.gnome.org) 

and GNOME-Look (http://gnome-look.org). The GNOME Art web site is officially supported. 

GNOME-Look tends to be driven more by enthusiasts. Both offer a massive choice of 

theme components. 
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■Caution  Be warned that there is sometimes artistic nudity on some of the wallpapers available from 

GNOME-Look.

The GNOME Art site, shown in Figure 10-3, gives you access to just about every theme 

ever created for GNOME. In fact, the site also contains wallpaper selections, icons, and 

much more. All of the offerings are free to use.

Figure 10-3. The GNOME Art site contains the latest themes, and you can use all of them 

with Ubuntu.
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Installing new theme components is easy, and the instructions here work just as well 

for the GNOME-Look site. If you wish to install a new window border, for example, click 

the link to browse the examples, and when you find one you like, click to download it. It 

will be contained in a .tar.gz or .tar.bz2 archive, but you don’t need to unpack it (be 

sure to select the Save File option from the Firefox dialog box). Simply select System ➤ 

Preferences ➤ Appearance, and click the Install button on the Theme tab. Then browse to 

the downloaded theme and click Open. You can also just drag the .tar.gz or .tar.bz2 file 

onto the Theme tab of the Appearance Preferences dialog box for an instant installation. 

Either way, you’ll be asked if you want to use the new theme component immediately. 

You can say yes, or choose it later from the Customize Theme dialog box (opened by 

clicking the Customize button in the Appearance Preferences dialog box), where it will be 

available on the relevant tab.

You can delete the downloaded file when you’re finished.

■Note  The same principle of sharing that underlines the GPL software license is also usually applied to 

themes. This means that one person can take a theme created by someone else, tweak it, and then release 

it as a new theme. This ensures constant innovation and improvement. 

Changing the Wallpaper

It’s easy to switch wallpapers under Ubuntu. You can also add your own wallpaper and 

set wallpaper size, or select a background color if you don’t wish to use wallpaper. These 

changes can be made from the Background tab of the Appearance Preferences dialog box 

(System ➤ Preferences ➤ Appearance), shown in Figure 10-4.

■Tip  The default backgrounds provided by the GNOME project include several wonderful nature pictures 

and some cool patterns. However, they aren’t included out of the box with Ubuntu. To install them, search for 

gnome-backgrounds in the Synaptic Package Manager. Also, don’t forget that the GNOME Art web site 

(http://art.gnome.org) offers many wallpaper packages for download. 
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Figure 10-4. Wallpapers can be zoomed or scaled to fill the screen using the Style drop-down 

list (this figure includes wallpapers from the gnome-backgrounds package). 

Switching and Adding Wallpaper

On the Background tab, you can select from a short list of different wallpapers, including 

the following:

No wallpaper: This is the leftmost choice. To change the background color, click the 

color box in the Colors section at the bottom of the dialog box. 

Elephant: This is an image of an elephant’s hide rendered with brown shades.

Heron: This is the default wallpaper. It’s an image of an abstract heron painted 

with the Ubuntu logo color on the foreground, with swirls of brown shades on the 

background.

Ubuntu Simple: This shows swirls of different brown shades in the background.
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■Tip  You can right-click the desktop and choose Change Desktop Background to access the same menu of 

wallpaper choices.

If you want to use a picture of your own as wallpaper, click the Add button, and then 

browse to its location.

Choosing Wallpaper Style

From the Style drop-down list on the Background tab, you can select from the following 

choices:

Centered: This option places the wallpaper in the center of the screen. If the wall-

paper is not big enough to fill the screen, a border appears around the edge. If it’s 

bigger than the screen, the edges of the wallpaper are cropped off.

Fill Screen: This option forces the picture to fit the screen, including squashing or 

expanding it if necessary (known as altering its aspect ratio). If the wallpaper isn’t in 

the same ratio as the screen, it will look distorted. Most digital camera shots should be 

okay, because they use the same 4:3 ratio as most monitors (although if you have a 

widescreen monitor, a digital camera picture will be stretched horizontally).

Scaled: Like the Fill Screen option, this option enlarges the image if it’s too small or 

shrinks it if it’s too big, but it maintains the aspect ratio, thus avoiding distortion. 

However, if the picture is in a different aspect ratio than the monitor, it may have 

borders at the edges.

Zoom: Like Fill Screen, this option forces the picture to fit the screen, without any 

borders at the top and bottom. However, it avoids altering the aspect ratio. If the wall-

paper isn’t the correct aspect ratio then parts of the top/bottom or left/right of the 

image may be cropped off.

Tiled: If the picture is smaller than the desktop resolution, this option simply repeats 

the picture (starting from the top left) until the screen is filled. This option is primarily 

designed for patterned graphics.
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Specifying Wallpaper Colors

From the Colors drop-down list on the Background tab, you can select from the following 

choices:

Solid Color: This option fills the wallpaper with one uniform color. You are provided 

one color button to set the color.

Horizontal Gradient: This option fills the wallpaper with a one color on the left, 

blending with another color from the right. You are provided two color buttons to 

specify both colors.

Vertical Gradient: This option fills the wallpaper with a color on top, blending with 

another color at the bottom. You are provided two color buttons to specify both colors.

To specify the color or colors that will be used, click the color buttons beside the Colors 

drop-down list. The Pick a Color dialog box will appear. Select a color by clicking or drag-

ging the color wheel. You can also use the eyedropper tool to obtain any color displayed 

on your screen, including anywhere on the desktop or in open windows. Simply click the 

tool on the color.

If none of this works for you, you can manually provide the hue, saturation, value (HSV) 

or red, green, blue (RGB) values or color name by specifying the combination of hexadecimal 

digits (this will be familiar to web designers). 

A preview of your selection is shown at the bottom left of the dialog box in the right 

color preview bar. The previous color that you selected is shown in the left color preview 

bar. Click the OK button when you’ve chosen your preferred color.

Setting Font Preferences

Ubuntu lets you change the fonts that are used throughout Ubuntu (referred to as system 

fonts). You can also alter how they’re displayed.

To change a system font, open the Appearance Preferences dialog box (System ➤ 

Preferences ➤ Appearance), and click the Fonts tab, as shown in Figure 10-5. Click the 

button next to the system font you want to change, and then choose from the list. You 

can also set the font point size, perhaps to make the labels beneath icons easier to read.

By clicking the entries in the Rendering section of the Fonts tab, you can change how 

fonts look on your monitor. This will alter the antialiasing and hinting of the font. Anti-

aliasing softens the edges of each letter to make them appear less jagged. Hinting affects 

the spacing and shaping of the letters. Used together, they can make the on-screen text 

look more pleasant. Try each Rendering setting in sequence to see which looks best to you 

(the text in the dialog box will update automatically to show the changes). Nearly everyone 

with a TFT-based screen, including notebook users, finds the Subpixel Smoothing 

option best.
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Figure 10-5. You can alter the way fonts appear on screen by using the Fonts tab of the 

Appearance Preferences dialog box.

BYTECODE HINTING

Two font-hinting subsystems are available under Ubuntu: Autohinting and Bytecode Interpreter. There’s 

a lengthy debate about which produces the best results. Personally, we prefer to use the Bytecode Inter-

preter, because we believe it leads to the cleaner fonts, but others say Autohinting is better in this 

regard. Some people say that the Bytecode Interpreter is worth using only if you make heavy use of the 

Microsoft TrueType Core Fonts (see Chapter 21 to learn how to install these fonts).

Follow these steps to switch between the Bytecode Interpreter and Autohinting systems:

1. Open a terminal window (Applications ➤ Accessories ➤ Terminal).

2. In the terminal window, type the following:

sudo dpkg-reconfigure fontconfig-config

3. On the first screen of the configuration program, select Native to activate the Bytecode Interpreter. 

Alternatively, you can choose Autohinting or even None, which will turn off the hinting system.
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4. On the next screen, you can select whether subpixel rendering is activated. This is useful only 

for TFT screens (including notebooks). Select Automatic, or if you use a TFT monitor and want 

to ensure the option is activated, select Always.

5. The third screen offers the option of using bitmap fonts. These are fonts that, unlike the TrueType 

fonts used within the rest of Ubuntu, don’t scale beyond their original sizes. There’s no harm in 

enabling them, because they can sometimes be useful as system fonts.

6. After making this choice, the configuration program will quit. Then you must update the changes 

you’ve made by using the following command:

sudo dpkg-reconfigure fontconfig

7. Once the program has finished configuring the software, restart your X server by logging out and 

then back in again.

Configuring General Interface Options

Ubuntu lets you modify the way the menus and toolbars are displayed. To configure these 

interface options, open the Appearance Preferences dialog box (System ➤ Preferences ➤ 

Appearance) and click the Interface tab. This tab offers three options:

Show icons in menus: Here, you have the option to display/hide the icon placed 

before each item in menus used throughout the GNOME desktop and GNOME appli-

cations, such as the Gedit text editor. It’s best to leave the icons visible, since visuals 

help describe the purpose of each menu item, but ultimately it’s a matter of personal 

choice. Menus are certainly smaller if they have no icons. You can get an idea of the 

changes when you click the File or Edit faux menu in the Preview section.

Editable menu shortcut keys: By enabling this option, you can add, modify, or delete 

a keyboard shortcut of a menu item in most GNOME applications. To add or modify 

a keyboard shortcut in an application, click the menu containing the option, hover 

your mouse pointer over the menu item of interest, and then press your desired key 

or a combination of keys. To delete a keyboard shortcut, just hover your mouse pointer 

over the menu item you want to remove and press the Delete key. 
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■Note  Bear in mind that some applications included with Ubuntu, such as OpenOffice.org, are not GNOME 

applications, so they may not allow you to edit their shortcut keys. Those that are GNOME desktop applica-

tions will say so in the Help ➤ About dialog box. 

Toolbar button labels: This will affect where the text in toolbar buttons appears: below 

or beside the icon (buttons in dialog boxes are not affected). You can also select to 

display only icons in buttons or only text. Select the desired option from the drop-

down list, and then view the results in the faux buttons in the Preview section. 

■Tip   The Preview section of the Appearance Preferences dialog box is useful for showing the effects of 

the changes, but to see how what you’re changing affects a real application, we suggest opening Gedit and 

leaving it in the background behind the Appearance Preferences dialog box. Gedit is a standard GNOME appli-

cation that ably demonstrates the GNOME look and feel. 

Using Desktop Visual Effects

Provided your computer is compatible, and your computer is utilizing the correct graphics 

card drivers (see the “Installing 3D Drivers and Activating Desktop Visual Effects” section 

in Chapter 8), you can opt for visual effects on your Ubuntu desktop. 

Three basic settings for desktop visual effects are available: None, Normal, and Extra. 

You can switch between them by clicking System ➤ Preferences ➤ Appearance, and then 

selecting the Visual Effects tab of the Appearance Preferences dialog box. 

As you might expect, the None option turns off the effects. This can be useful if your 

computer slows down when the effects are in use. The Normal setting implements the 

standard set of effects, offering subtle but not overly noticeable changes to the interface, 

and is the default choice if your computer is capable of effects. The Extra setting adds a 

handful more effects, largely for fun but also with some offering productivity benefits. 

Additionally, you can opt to install some extra software that gives you even more fine-

grained control over what effects are used. The following sections discuss each of these 

choices for visual effects.
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Using the Standard Visual Effects

The standard visual effects, used when the Normal setting is chosen, add shadows to 

windows and also add minimize animations so that programs literally appear to shrink 

into the panel. You might also notice that inactive windows and their title bars are trans-

lucent. Additionally, when a window is opened or closed, you see the window appear or 

fade away, respectively. 

There are several more subtle visual effects, requiring particular key combinations, 

as follows: 

Visually impaired tools: To zoom into any area of the screen, press the Windows key 

and turn the mouse wheel to adjust the zoom level. You can also press Windows+1, 2, 

or 3 key to zoom into three different levels, respectively. Additionally, you can invert 

the colors (like a photographic negative) either for the entire desktop or just for the 

current program window. Press Windows+N to toggle the window as a negative, as 

shown in Figure 10-6. Press Windows+M to toggle the entire screen as a negative. 

Figure 10-6. You can filter colors of windows or the entire screen as a visual aid.
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Virtual desktops: If you use virtual desktops, as described in Chapter 7, you’ll be pleased 

to know that the desktop effects system enhances the experience. Press Windows+E to 

get a miniature view of your virtual desktops arranged in a grid, as shown in Figure 10-7. 

(Note that the figure shows four virtual desktops; the default setting on an Ubuntu 

system is only two desktops.) To switch to a virtual desktop, just point your mouse to 

the virtual desktop of choice and double-click. You can also switch from one virtual 

desktop to another from the desktop by moving the mouse pointer to an empty area 

of the desktop and then turning the mouse wheel, which will cause the desktops to 

slide sideways out of view. Press Ctrl+Alt+arrow key for the same effect. As you navi-

gate from one virtual desktop to another, a grid where each cell represents each 

virtual desktop will appear in the center of the screen, and a cell will be highlighted for 

a short period of time to let you know which virtual desktop you are on right now. 

Figure 10-7. Pressing Windows+E gives you a miniature view of your virtual desktops.
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Application Switcher: As well as moving between virtual desktops, you can navigate 

through applications with the Application Switcher. Just press Alt+Tab to see the list of 

running applications in miniature view, arranged horizontally in the center of the screen, 

as shown in Figure 10-8. Press the Tab key repeatedly until you find the desired applica-

tion at the center of the list. Release the Alt key to switch to the desired application.

Figure 10-8. To use the Application Switcher, hold the Alt key and press the Tab key until you 

find the desired application at the center of the list.

Using the Extra Visual Effects

By selecting the Extra option from the Visual Effects tab of the Appearance Preferences 

dialog box, you can enable a handful more visual effects. These include all the features 

of the Normal effects and then some. For starters, you will notice that when you drag or 

maximize a window, the window becomes “wobbly”—part of it will linger behind the rest 

of the window, as if affected by momentum. The Application Switcher effect is also enhanced, 

and will display previews of open programs in 3D form, as shown in Figure 10-9.
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Figure 10-9. The 3D Application Switcher is displayed by pressing Windows+Tab.

Personalizing Visual Effects

If you are unsatisfied with the default choices for visual effects, you can install the 

CompizConfig Settings Manager tool. This gives you complete control over the Compiz 

Fusion system, which provides Ubuntu’s visual effects (see Chapter 8). Bear in mind that 

some of these settings are very technical, and little provision is made for those who are 

new to the effects subsystems. 

You can install the tool using the Synaptic Package Manager (System ➤ Administration ➤ 

Synaptic Package Manager). You’ll need to enter your password when prompted. Click 

the Refresh button to reload the repository listings. Then click the Search button and 

enter compizconfig-settings-manager as a search term. In the list of results, locate the 

program and click the check box. Then choose to Mark for Installation. When prompted 

to mark additional required changes, click the Mark button. Finally, click the Apply button on 

the Synaptic toolbar.

Once the tool is installed, select System ➤ Preferences ➤ Advanced Desktop Effects 

Settings. The CompizConfig Settings Manager window will appear, as shown in Figure 10-10. 
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Figure 10-10. The CompizConfig Settings Manager tool offers advanced customization of 

visual effects in Ubuntu.

Compiz Fusion works by packaging each effect as a plug-in, and CompizConfig Settings 

Manager simply lets you switch these plug-ins on and off, as well as change their settings. 

One of the most important settings you can change for most plug-ins is the keyboard 

combination that activates them.

On the right side of the main window is the list of plug-ins. You can enable them by 

checking the check box beside them. You can also change the settings of the plug-in by 

clicking the plug-in name and icon. This opens the settings page for the plug-in, with a 

single or few tabs containing configuration settings. You’ll also see a brief description of 

the effect on the left side of the program window. When you’ve finished, click the Back 

button.

In the left column, you can use the Filter text box at the top to search for a particular 

plug-in; the search results will be displayed on the right side of the window. Beneath the 

Filter section is the Category listing, which groups the plug-ins by purpose. Clicking any 

category will update the list of plug-ins on the right side of the window. To return to the 

main program window, click the Back button. The categories are as follows:
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All: All available plug-ins will be displayed in the main window.

General: This section contains just the General Options plug-in, which provides 

configuration settings for keyboard shortcuts for some of the effects, virtual desktop 

size, display settings, transparency settings for windows, and more. Some of the 

settings are quite technical and are perhaps best left alone unless you know what you 

are doing. 

Accessibility: This section contains plug-ins that will help people with physical disabili-

ties use the desktop more conveniently with visual aids. It contains plug-ins that make 

the active window more visible, magnify the screen for visibility issues, change colors, 

and aid in finding the mouse pointer. To find out what keyboard combination is 

required to activate any particular effect, click the plug-in’s icon to change its settings 

and look to the button alongside each heading.

Desktop: This section contains plug-ins that enhance desktop behavior. If you use 

virtual desktops, plug-ins such as Desktop Cube and Rotate Cube can turn these into 

sides of a 3D cube that rotates when you switch desktops, as described earlier. Desktop 

Wall and Desktop Plane render these workspaces as if they were part of one surface. 

You might notice that some plug-ins have the same functionality; CompizConfig 

Settings Manager will offer to disable any that do when you select a new option. Plug-

ins such as Viewport Switcher and Expo make it easier to preview and navigate work-

spaces. Show Desktop and Fade to Desktop add special effects to clear the desktop of 

clutter. Like many effects plug-ins, these tie in with the existing features of Ubuntu—

in this case, the Show Desktop feature and button, located at the bottom left of the 

desktop by default. 

Effects: This section contains plug-ins that add special effects to certain aspects of the 

desktop. Some you have already seen, such as Wobbly Windows, which is part of the 

Extras scheme. But others are more extreme. For example, there are several plug-ins 

that add eye candy to windows, such as Blur Windows, Animations, Fading Windows, 

and Window Decoration Reflection. 3D Windows, Cube Gears, and Cube Reflection 

add decorations as you traverse the 3D cube. Other plug-ins affect the entire screen, 

such as adding water puddles and wipers with the Water effect or adding fire on the 

screen with the Paint Fire on the Screen effect. Some need keyboard combinations to 

activate them—to find out what these are, click the plug-in icon. 
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Extras: This section includes effects useful for developers, as well as some plug-ins 

that simply could not be filed elsewhere. These include displaying the Compiz Fusion 

splash screen after logging in, benchmarking the performance of Compiz Fusion, 

viewing a thumbnail of a window by pointing the mouse at its entry on the Taskbar, 

and taking a screenshot. One notable plug-in is Annotate, which enables you to draw 

on the screen. This can be useful for demos and presentations when stressing key points. 

Image Loading: These plug-ins are technical and are required in the background to 

load image formats and text that will be used by other plug-ins for rendering. Do not 

disable them. 

Utility: This section contains mostly plug-ins that work behind the scenes and a few 

that work externally. Unless you know what you are doing, you shouldn’t change any 

of these settings or disable any of the plug-ins. 

Window Management: These plug-ins enhance window management functionality. 

For example, some of the plug-ins project the Taskbar in different ways, such as 2D, 

in a ring, and in a 3D ring. Another example is the Group and Tab Windows plug-in, 

which you can use to group and tab windows.

Uncategorized: These include plug-ins that do not belong to any group. Note that, in 

our tests, selecting this was like selecting All—all the plug-ins were displayed. We had 

to scroll to the bottom of the window to see the Uncategorized plug-ins. 

Beneath the Categories list is the Preferences option, which is used for adjusting internal 

settings of Compiz Fusion, such as the back-end profile and including and excluding 

plug-ins. You can leave these settings untouched.

Lastly, the Advanced Search option allows you to search through options within plug-

ins. The search results will first be narrowed down to a list of plug-ins in the main window. 

After selecting from the list of plug-ins, a new list will be displayed with narrowed down 

results containing a list of grouped options. After selecting from the list of grouped options, 

you’ll see a narrowed down list of options that you can use to configure the plug-in’s settings. 

USING DESKTOP WIDGETS

If you are a fan of Windows Vista’s Sidebar, Macintosh OS X’s Dashboard, or Yahoo!’s Widgets, you can 

use something similar under Ubuntu, called screenlets. To use these, you need to install the Screenlets 

package. This requires you to first install CompizConfig Settings Manager, as described in the main text. 

Then use that program to enable the Widgets Layer plug-in (look under the Desktop category). Finally, 

use the Synaptic Package Manager (System ➤ Administration ➤ Synaptic Package Manager) to search 

for and install the Screenlets package. 
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Run Screenlets by clicking System ➤ Preferences ➤ Screenlets. Once the Screenlets Manager 

window appears, select the screenlet you would like to enable by clicking it and then clicking the 

Launch/Add button. Following this, you should be able to click and drag the screenlet. Right-click a 

screenlet and select Properties to change its settings. 

You have two choices regarding how and when the screenlet appears:

• Keep the widget on the screen at all times (the default), perhaps arranging widgets on the right 

side of the screen as with Windows Vista.

• Add the widget to the Widget Layer, which is just like OS X’s Dashboard and will appear only when you 

hit F9 (and will subsequently disappear when the mouse is clicked). To add the widget to the Widget 

Layer, right-click it, select Window, and then click Widget. 

Of course, you can have the best of both worlds, keeping some widgets on the screen and putting 

lesser-used items on the Widget Layer. 

If you would like to add more screenlets than those available by default, go to http://

screenlets.org. Under the Downloads head, click the “third-party screenlets” link. Once you’ve 

downloaded the screenlet, you can install it by clicking Install Screenlet in the Screenlets Manager 

window and then navigating to the downloaded screenlet. 

Configuring Input Devices
Mouse and key repeat speeds are personal to each user, and you may find the default 

Ubuntu settings not to your taste, particularly if you have a high-resolution mouse such as 

a gaming model. Fortunately, changing each setting is easy. You’ll find the relevant options 

under the System ➤ Preferences menu.

Configuring Mouse Options

Select System ➤ Preferences ➤ Mouse to open the Mouse Preferences dialog box, which 

has General and Accessibility tabs. On a laptop, you might also see the Touchpad tab.

General Mouse Settings

On the General tab of the Mouse Preferences dialog box, shown in Figure 10-11, you can 

configure the following options:
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Figure 10-11. The Mouse Preferences dialog box lets you tame that mouse.

Mouse Orientation: This option lets you set whether the mouse is to be used by a left-

handed or right-handed person. Effectively, it swaps the functions of the right and left 

buttons. 

Locate Pointer: This option allows you to show where the mouse is by displaying a 

ripple surrounding the mouse pointer when you press the Ctrl key. This can be useful 

for partially sighted people who may not be able to locate the cursor on a busy desktop.

Acceleration: This setting controls how fast the mouse moves. Whenever you move 

the mouse, the pointer on the screen moves a corresponding amount. However, the 

cursor actually increases in speed the more you move your hand (otherwise, you would 

need to drag your hand across the desk to get from one side of the screen to the other). 

This is referred to as acceleration. If you set the acceleration too high, the pointer will 

fly around the screen, seemingly unable to stop. If you set it too slow, you’ll need to 

ramp the mouse several times to make it go anywhere.
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Sensitivity: This setting controls how quickly the acceleration kicks in when you first 

move the mouse. Choosing a higher setting means that you can move the mouse rela-

tively quickly before it starts to accelerate and cover more screen space. A low setting 

means that acceleration will begin almost as soon as you move the mouse. Higher 

sensitivity settings give you more control over the mouse, which can be useful if you 

use image-editing programs, for example.

Drag and Drop: This setting determines the amount of mouse movement allowed in 

a click-and-drag maneuver before the item under the cursor is moved. It is designed 

for people who have limited dexterity and who might be unable to keep the mouse 

perfectly still when selecting an item. In such cases, a large threshold value may be 

preferred.

Double-Click Timeout: This is ideal for people who are less physically dexterous, 

because the double-click speed can be slowed down. On the other hand, if you find 

yourself accidentally double-clicking items, you can speed it up. Test your settings by 

double-clicking the light bulb image.

Changes are made as each setting is adjusted, so to test the new settings, simply move 

your mouse.

Accessibility Settings

The settings on the Accessibility tab can help people with physical disabilities use the 

mouse. However, to enable these features, you need to enable Assistive Technologies in 

Ubuntu first, as follows:

1. Open the Assistive Technologies Preferences dialog box (System ➤ Preferences ➤ 

Assistive Technologies).

2. Check the Enable Assistive Technologies box, and then click the Close and Log Out 

button (this is necessary to start the background services). 

3. Select Log Out in the Shutdown dialog box, and then log back in again, when 

prompted. 

4. After logging in, return to the Accessibility tab of the Mouse Preferences dialog box 

(System ➤ Preferences ➤ Mouse).

From the Accessibility tab, you can enable simulated secondary click and dwell click 

options. Checking “Trigger secondary click by holding down the primary button” simu-

lates a right-click when you hold the left-click for a certain amount of time (useful for 

those having trouble right-clicking). This amount of time can be configured by moving 

the Delay slider to the left for a faster response or to the right for a longer delay. 
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A dwell click allows you to simulate a mouse-click action after the mouse pointer has 

been left idle for a certain amount of the time. To enable this feature, check “Initiate click 

when stopping pointer movement.” You can set the length of the idle time by moving 

the Delay slider to the left for less idle time or to the right for a longer delay. The Motion 

Threshold setting determines the amount of mouse movement allowed while the mouse 

is still considered idle (useful for those who might be unable to control small movements 

of their hands). Moving the Motion Threshold slider to the left makes the mouse pointer 

sensitive; moving it to the right makes the pointer less sensitive. You can choose two types 

of dwell click: 

Choose type of click beforehand: This option automatically clicks the mouse when 

the mouse pointer is idle. If you want to choose the type of mouse click each time, put 

a check in the box beside Show Click Type Window. This will show a floating window, 

from which you can select various types of clicks, such as single-click, double-click, 

and so on. Alternatively, you can choose the mouse click from the Dwell Click applet 

instead. (Applets are discussed in the “Working with Applets” section later in this 

chapter.)

Choose type of click with mouse gestures: This option allows you to choose the type 

of mouse click to execute when the mouse movement is idle by moving the mouse in 

a certain direction, usually up, down, left, or right. Just wait until the mouse turns into 

a cross and then move the mouse. Once you’ve performed the movement, the mouse 

will return to its original location before it was moved. All of the mouse movements 

can be customized by changing the gestures in the drop-down lists for Single Click, 

Double Click, Drag Click, and Secondary Click. 

Touchpad Settings

The Touchpad tab appears on laptops only. You can set the following options:

Enable touchpad: This allows you to enable or disable the touchpad. Disabling the 

touchpad is useful, because typing while inadvertently touching the touchpad will 

change the position of the cursor, which is a pain. 

Enable mouse clicks with touchpad: This allows you to simulate a mouse click by 

tapping the mouse pad. 

Enable vertical and horizontal scrolling on your touchpad: This is similar to the 

effect of turning the scroll wheel. For vertical scrolling, a small region at the top-right 

corner down to the bottom-right corner of the touchpad becomes the vertical scroll 

region. For horizontal scrolling, a small region at the lower-left corner to the lower-

right corner of your touchpad becomes the horizontal region. 
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Changing Keyboard Settings

Select System ➤ Preferences ➤ Keyboard to open the Keyboard Preferences dialog box. 

This dialog box has five tabs: General, Layouts, Accessibility, Mouse Keys, and Typing Break.

General Settings

The General tab offers Repeat Keys settings and a Cursor Blinking slider. You can alter the 

rate of key repeat, which can be useful if you often find yourself holding down the Back-

space key to delete a sentence; a shorter setting on the Delay slider and a faster setting on 

the Speed slider can help. However, if you get the settings wrong, you may find double 

characters creeping into your documents; typing an f may result in ff, for example.

Modifying the Cursor Blinking slider setting may help if you sometimes lose the cursor 

in a document. A faster speed will mean that the cursor spends less time being invisible 

between flashes.

Layouts Settings

On the Layouts tab, you can choose your keyboard model, add an alternative keyboard 

layout, and configure layout options, as shown in Figure 10-12. Typically, the generic 

keyboard works fine for most setups. However, if you want to make full use of the extra 

keys on your keyboard, such as Mail, Web, Power, Sleep, Suspend, and so on, you should 

select your keyboard model. 

If you write in two different languages on your keyboard, it may be helpful to be able to 

switch between them. Click the Add button, and select the second language from the list. 

To switch from one language to another, you can add the Keyboard Indicator applet in a 

panel and toggle from one language to another by clicking the applet. (Applets are discussed 

in the “Working with Applets” section later in this chapter.)

The Layout Options dialog box, accessed by clicking the Layout Options button, lets 

you select from a multitude of handy tweaks that affect how the keyboard works. For 

example, you can configure the Caps Lock key to act like a simple Shift key, or you can 

turn it off altogether. You can configure the Windows key so that it performs a different 

function, too. Put a check alongside the options you want after reading through the exten-

sive list.
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Figure 10-12. You can have more than one language setting in place for a keyboard, which is 

handy if you need to type in a foreign language.

Accessibility Settings

As with the mouse, there are also accessibility options for keyboard users to help people 

with physical disabilities. On the Accessibility tab, you can configure the following settings: 

General: You have an option to enable/disable accessibility features from the keyboard.

Sticky keys: As its name suggests, this feature holds down keys such as Shift, Ctrl, and 

Alt while you press another key on the keyboard. This is useful for people unable to 

press more than one key at once, but who need to use keyboard shortcuts, Ctrl+S, within 

applications. To enable sticky keys, check the Simulate Simultaneous Keypresses 

option. You can test sticky keys by running Nautilus (Places ➤ Home Folder). Try 

pressing Alt and F sequentially; Nautilus will open the File menu as if you pressed 

those keys simultaneously. If you would like to disable sticky keys on the fly, without 

having to use this dialog box, select “Disable sticky keys if two keys are pressed together.” 

You can test this by pressing Ctrl+Alt. A Sticky Keys Alert dialog box will appear to 

prompt you to disable sticky keys. 
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Slow keys: This feature controls the reaction rate of keys. By moving the Delay slider 

to the left, the reaction rate of the keys becomes faster. By moving the slider to the 

right, the reaction rate of the keys becomes slower, to the point that you would need 

to hold the key for certain amount of time for it to be considered as a key press. This 

has obvious uses for people with limited dexterity in their fingers. 

■Tip  To enable/disable sticky keys at any time, just press the Shift key five times to toggle the sticky keys 

feature. To enable/disable slow keys, hold the Shift key for 8 seconds.

Bounce keys: This feature controls the repetition of letters on the screen when the 

same key is accidentally pressed. By moving the slider to the left, the repeat rate will 

be quicker; moving it to the right adds time for the key to be repeated. 

At the bottom of the dialog box is a text box for typing to test the settings you’ve just 

configured. You can also enable sound notifications by clicking the Notifications button. 

These notifications will let you know when the keyboard accessibility features have been 

enabled or disabled. You can set sound alerts for accessibility in general, sticky keys, slow 

keys, and bounce keys. 

Mouse Keys Settings

The mouse keys feature lets you use your numeric keypad to control the mouse pointer. 

By checking “Allow to control the pointer using the keyboard” and pressing the Num Lock 

key, you can move the mouse pointer by typing from the numeric keypad. 

With mouse keys enabled, the 5 key both simulates a mouse click and acts as the center 

of a directional wheel surrounding it. The 1, 2, 3, 4, 6, 7, 8, and 9 keys simulate mouse 

direction. Some numeric keypads have arrows on them to indicate this. 

You can move the Acceleration slider to adjust the time it takes while pressing the mouse 

keys for the mouse movement to reach full speed. 

The Speed slider sets the distance offset of the mouse pointer when you press a mouse 

key. By moving the Speed slider left, the mouse pointer covers a smaller distance when 

you press a mouse key, giving you the illusion that the mouse movement is slower. By 

moving the Speed slider right, the mouse pointer covers a larger distance when you press 

a mouse key, giving you the illusion that the mouse movement is faster. 

The Delay slider determines the amount of time to press the mouse keys before the 

mouse pointer starts to move. You can set the delay by moving the Delay slider to the left 

for a quicker response time and to the right for a longer delay.
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Typing Break Settings

The Typing Break tab features a function that can force you to stop typing after a prede-

termined number of minutes. It does this by blanking the screen and displaying a “Take a 

break!” message. Note that a notification area icon will appear before the break time to 

give you advanced warning of the lockout.

Creating Keyboard Shortcuts

Ubuntu lets you define your own keyboard shortcuts for just about any action on the 

system. To create a shortcut, select System ➤ Preferences ➤ Keyboard Shortcuts. In the 

dialog box, search through the list for the action you want to create a shortcut for, click it, 

and then press the key combination you want to use. For example, you might locate the 

Volume Up and Volume Down entries in the list, click each, and press Ctrl+left arrow and 

Ctrl+right arrow. Then you will be able to turn the volume of your sound card up or down 

by holding down Ctrl and tapping the left or right arrow key, respectively.

■Caution  Be careful not to assign a shortcut to a popular key. It might be nice to make Totem Media Player 

appear when you hit the spacebar, for example, but that will mean that it will start up several times whenever 

you type a sentence in a word processor! Also be aware that some key combinations are used by applications. 

Within OpenOffice.org’s Writer, for example, the Ctrl+left/right arrow key combination moves you from word 

to word in a paragraph. If you define those combinations as shortcuts, you will no longer have this functionality.

An example of a handy shortcut is to configure your /home folder to appear whenever 

you press Ctrl+Home. This can be done by locating the Home Folder option under the 

Desktop heading.

Personalizing Login Options

You can even personalize the login screen under Ubuntu. This is known technically as the 

GNOME Display Manager, or GDM. To access its configuration options, select System ➤ 

Administration ➤ Login Window.

■Note  On our test system, the GNOME Display Manager took a surprisingly long time to start up, and 

initially we thought it had crashed. You may need to wait 1 or 2 minutes for it to appear. 
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You will see the Login Windows Preferences dialog box, which has six tabs: General, 

Local, Remote, Accessibility, Security, and Users.

General Settings

The General tab allows you to customize the following settings:

Hide visual feedback in the password entry: When you check this option, the pass-

word mask (the circles that appear when you type in a password field) is not displayed 

as you type your password when you are logging in. This prevents people from deter-

mining the length of your password by looking at your screen as you type. 

Disable multiple logins for a single user: When you check this option, a user will have 

only one session to work on, even if he logs on multiple times, to save on computing 

resources. 

Default session: This is basically, the type of session that will run when you log in. You 

have five options: 

• The Run Xclient Script option allows you to run a customized script, if it exists, 

or the system-wide script (if the customized script does not exist) that specifies 

which programs you would like to run during startup. This is for very advanced 

users. If you wish to control which programs start when GNOME does, it’s best to 

use the Sessions program instead (System ➤ Preferences ➤ Sessions), as described 

in Chapter 30.

• The GNOME option allows you to run the GNOME desktop environment during 

startup. GNOME is Ubuntu’s default desktop environment, but you can also 

install other desktop environments such as KDE and Xfce by using the Synaptic 

Package Manager, as described Appendix D.

• The Secure Remote Connection option allows you to connect to a remote desktop 

with a secure/encrypted connection. Once you log in to your computer, you will 

be prompted to specify the IP address or hostname of the remote desktop, user-

name, and password. At this point, the desktop that will appear on your screen is 

the remote desktop and not the local desktop. The main requirement is that the 

remote desktop has the ssh server program installed (see Chapter 33 for instruc-

tions on how to install the ssh program). 

• The Failsafe GNOME and Failsafe Terminal options are used for troubleshooting 

if you fail to log in normally.
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GtkRC file: This option is useful if you want to customize the theme for GDM, but this 

is again only for advanced users. It’s easier to customize the login screen by using the 

options on the Local tab, as described next. 

Clock notation: You have the option to display the time in 24 or 12 hour notation on 

the login screen. The Auto setting will match the rest of the system preferences for 

display of 12/24 hour time. 

Local Settings

On the Local tab, you can configure settings for the look and feel of the login screen. These 

settings do not affect remote logins (those that take place over a network or even the Internet). 

Local logins are the standard type that you use to access Ubuntu while sitting in front of 

the computer. The options are as follows:

Style: In the Style drop-down list, you can choose the type of login screen people 

logging in locally will see: 

• Themed, which is to say one that includes a pretty graphic such as the Ubuntu 

logo

• Themed with Face Browser, which shows a pretty graphic and user-selected 

photographs (see the “Changing Your Login Picture” section later in this chapter)

• Plain, which shows a simple plain color background with the GNOME logo

• Plain with Face Browser, which is like the Plain option but also shows user-

selected photographs

Theme: In the Theme drop-down list, you have two choices on how many login 

screen themes you would like to use. The first choice is Selected Only, which means 

you will use only one login theme from the selection. The second choice is Random 

from Selected, which means you can select several login screen themes, and the login 

theme that will be displayed is randomly selected from those themes. Assuming that 

you select Themed from the Style drop-down list, you can select the actual theme you 

want from the Theme list. The default choice is Human, which features the Ubuntu 

logo and color scheme, but you can also select from a handful of other designs. 

Show Actions Menu: By unchecking this option in the Menu Bar section, you can 

deactivate the Actions menu on the login screen, so the user will not be able to restart 

or shut down the computer from the login screen. This can be useful for security 

purposes. 
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Include Hostname Chooser (XDMCP) Menu Item: By unchecking this option, you 

can remove the option from the Actions menu that allows users to log in to a remote 

system. 

Custom: By selecting Custom under the Welcome Message heading, you can have the 

login screen display a custom sentence, but only if the Theme allows this—the default 

Human login screen doesn’t. 

By clicking the Add button, you can install new login screen themes, which, as with 

other GNOME theme components, can be downloaded from http://art.gnome.org.

Remote Settings

The Remote tab controls X Display Manager Control Protocol (XDMCP) logins. This is 

considered a very insecure method of remotely accessing Ubuntu and should be disabled. 

We discuss more secure options for remotely accessing Ubuntu in Chapter 33.

Accessibility Settings

The Accessibility tab lets you activate GNOME’s accessibility tools during login, which can 

aid those with physical disabilities. If you’ve chosen Plain or Plain with Face Browser as 

your login theme (on the Local tab), you’ll see the option Allow Users to Change Fonts and 

Colors. This allows you to change the font and colors of the login screen by selecting a 

different theme from the Theme menu of the login screen. 

Additionally, you can alter the sound that is heard when the login prompt is ready to 

take input. By putting a check alongside Login Successful and Login Failed, you can also 

choose sound effects to accompany those two actions.

Security Settings

The Security tab lets you alter login settings that might present a security risk to your 

system. The following options are available:

Enable automatic login: This check box lets you do away with the login screen 

completely when Ubuntu starts up and go straight to the desktop. Simply put a check 

in the box, and provide the login username. This presents obvious security issues, but 

if you’re the only person using the computer and if it’s located in a secure location, 

you might want to choose this option. 

Enable timed login: This option lets you select a user who will be logged in by default 

after a given period. This is useful if you want to present the opportunity to log in as a 

different user but also want to have the failsafe of logging in automatically, too. 
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Login retry delay: This option controls how long Ubuntu will pause after an incorrect 

username or password has been entered on the login screen. Increasing this value 

can put an irritating block in the way of anyone who intends to try various random 

username or password combinations to break into your system. But it can also be 

annoying to you should you mistype and then have to wait! 

Minimal UID: This option allows only users whose UIDs are higher than the one 

listed to log in. 

Allow local system administrator login: This option controls if the root user is allowed 

to log in, something which is considered a security risk. (This is only relevant if the root 

user account is enabled, which it isn’t by default under Ubuntu.)

Enable debug messages to system log/Deny TCP connections to X Server: These two 

options relate to security, and it’s unlikely you’ll ever need to use them. 

Allow login if all write permissions on user’s home directory: Since GDM saves user 

settings on your home directory, the permissions settings provide the conditions for 

GDM to access those files. If you receive error messages about problems accessing 

user settings such as the .drmc file when logging in, you may want to try to make GDM’s 

permissions lax by selecting this option. However, the better solution is to change the 

ownership and permissions of the affected files (see Chapter 14 for instructions on 

how to change permissions and ownership of files). 

The Configure X Server button lets you configure the X server that starts by default. 

Changing these settings could stop your computer booting to a GUI, so you shouldn’t 

alter the settings unless you know exactly what you’re doing.

Users Settings

On the Users tab, you can specify which users are offered as choices within GDM if the 

Face Browser option is activated on the Security tab. Bear in mind that Linux has many 

system user accounts that aren’t designed to allow logins. 

The “Include all users from /etc/passwd (not for NIS)” option is checked by default. 

This is a convenient setting, since all user accounts will be displayed in the login screen. 

except for usernames whose user IDs are lower than the Minimal UID setting in the Secu-

rity tab and users listed in the Exclude list. To reduce the list of users, you can add users to 

the Exclude list by clicking the Add button under the Exclude list. When the Add User 

dialog box appears, provide the username of the user to exclude from the list, and then 

click the Add button. However, if there are more users to exclude than users you would 

like to include on the login screen, it’s more appropriate to add users in the Include list 

instead. Uncheck “Include all users from /etc/passwd (not for NIS)” so that you can add 

users to the Include list. Then click the Add button under the Include list. When the Add 

User dialog box appears, provide the username of the user you wish to include, and then 

click the Add button.
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The Default Face and Global Face Dir options provide the default pictures of users in 

the face browser, if these users did not define a face image for themselves (see the next 

section). There is already a custom default face image per theme, but you can change the 

default image by providing the link to your preferred image in the Default Face option. 

The Global Face Dir, on the other hand, provides the directory where system-wide face 

images are stored. The default face image directory is /usr/share/pixmaps/faces, so you 

would need to add new default images there. To be able to use these face images in the 

face browser, the image must have the same name as the username of the user. For example, 

if you have a user who name is jane, the image filename must be renamed to jane followed by 

the image extension. Many image types are supported—you can use .gif, .tif, .png, and 

other files.

ASSISTIVE TECHNOLOGIES

You might know about the Accessibility tools under Windows, which help people with disabilities use the 

computer. It’s possible to use an on-screen magnifier, so that users can better see what they’re typing 

or reading, for example.

Under the GNOME desktop, the Accessibility tools are referred to as Assistive Technologies. To use 

them, select System ➤ Administration ➤ Preferences ➤ Universal Access ➤ Assistive Technology. 

Click the check box alongside Enable Assistive Technologies.

Here is what’s offered:

• The Screenreader uses a speech synthesizer to announce whatever you click on, as well as what-

ever you type. To alter its settings, click the Settings button. Note that this also lets you configure 

any Braille output devices that might be connected to the computer, and it lets you configure the 

on-screen magnifier. 

• The On-screen Keyboard can be used with a mouse, but is most useful when an alternative input device 

is used, such as a touch screen. As well as presenting a virtual keyboard, it shows the options on screen 

as a series of large and easy-to-activate buttons.

Changing Your Login Picture

If, when configuring the login options on the Local tab of the Login Window Preferences 

dialog box, as described in the previous section, you selected the Happy GNOME with 

Browser theme, or activated the Plain with Face Browser style, the login screen will display a 

picture alongside your name, as shown in Figure 10-13. You can click this and type your 

password to log in. You might be familiar with a similar system under Windows XP or 

Vista, or Mac OS X.
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Figure 10-13. The face browser lets each user choose an icon to appear on the login screen.

Users can choose their own login pictures by clicking System ➤ Preferences ➤ About 

Me. The About Me dialog box is designed for users to enter their personal details, such as 

their addresses, but they can also simply use it to choose photographs of themselves, or to 

simply add pictorial icons. To do this, click the empty square alongside your name at the 

top of the dialog box. You’ll be shown a file list of default icons, or you can navigate to your 

own. Ideally, the image you choose should be square and 96×96 pixels, although if the 

picture is too large, it will be automatically scaled down. Click OK when you’ve finished.

Adding and Removing Desktop Items
Virtually the entire Ubuntu desktop can be redesigned and restructured. You can move 

the Applications menu from the top of the screen to the bottom to be more like Windows, for 

example, or you can add numerous desktop shortcuts to popular applications and/or files.

Adding a Shortcut

Ubuntu’s nearest equivalent to a Windows-style desktop shortcut is a launcher, and you 

can create a launcher that points to a program or a file. If a launcher is created for a file, 
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Ubuntu will automatically launch the correct program to display the file. If you create a 

launcher to a .jpg file, for example, Ubuntu will know to launch the Eye of GNOME image 

viewer when the launcher is double-clicked.

Creating a Launcher

You can create a launcher two ways. One way is to simply click and drag an icon from one 

of the main menus to the desktop. This effectively copies the menu’s launcher to the desktop, 

rather than creating a new launcher, but the effect is the same. 

The other way to create a launcher is to right-click the desktop and select Create 

Launcher. In the Create Launcher dialog box, select whether you want to create a launcher 

to a file or application from the Type drop-down list (the third option, Application in 

Terminal, will open a terminal window and run the program within it; this is only for 

specialized use). Then fill in the Name and Command fields. Alternatively, if you don’t 

know the exact name and path of the file, click the Browse button, use the file browser 

dialog box to navigate to the file or program, and click to select it. (If you are creating a 

launcher to a program, you’ll probably find it in /usr/bin, which stores most of the Linux 

programs you use from day to day.) The Comment field can be left blank. If it’s filled in, it 

forms the tooltip text that will appear if you hover the mouse cursor over the launcher icon.

To choose an icon for your launcher, click the icon button on the left side of the Create 

Launcher dialog box. You can select from several predefined icons, as shown in Figure 10-14, 

or choose your own picture by clicking the Browse button. If you don’t choose an icon, a 

stock GNOME icon is used.

Figure 10-14. Creating a launcher is easy. Just fill in the Name and Command fields, and 

choose an icon.
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Creating a Link

Launchers have one failing, and that is that they’re only recognized by GNOME (and other 

desktop environments, such as KDE). You can’t create a launcher to an application and 

use it from the command line, for example. In technical terms, a launcher isn’t recognized 

by the underlying Linux file system.

The solution is to create a link to the file or program. This will actually create a symbolic 

link to the file. We explain more about file links in Chapter 14, but it’s enough to know that 

a link is very similar to a launcher, except it works on a file-system level.

■Note  Actually, Linux offers two types of link: a symbolic link, which is the most common type of link used 

under Linux, and a hard link, which is a cross between copying a file and creating a shortcut.

To create a link, locate the file you want to create the link to, right-click it, and select 

Make Link. The link will be created in the same directory as the original file, and you can 

then click and drag the new link to wherever you want it to appear, such as the desktop. 

You don’t need to choose an icon, because the link inherits the icon of the original file. For 

example, if it’s a picture link, it will inherit the thumbnail preview icon.

■Note  If you find the Make Link option grayed out, it’s likely that you don’t have sufficient permissions to 

write the link to the directory in question.

Personalizing the Panels

Panels are the long strips that appear at the top and bottom of the Ubuntu screen and play 

host to a choice of menus, applets, and icons. You can add a new panel by right-clicking a 

blank spot on an existing panel and selecting New Panel. The new panel will appear on 

one of the sides of the desktop. If you add a third one, in addition to the two default panels, it 

will appear on the right side of the desktop vertically. You can also remove a panel by right-

clicking it and selecting Delete This Panel.

■Caution  If you delete a panel, the arrangement of items it contains will be lost. Of course, you can always 

re-create the collection on a different panel.
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By right-clicking a panel and selecting Properties, you can change its size and dimen-

sions. For example, by unchecking the Expand box, you can make the panel shrink to its 

smallest possible size. Then, when you add new components (or, in the case of a panel 

containing the Window List, a new program is run), the panel will expand as necessary. 

This can be a neat effect and also creates more desktop space. (This effect is a little like the 

Mac OS X Dock and might help migrating OS X users feel at home!)

Selecting the Autohide feature will make the panel slide off the screen when there isn’t 

a mouse over it. Choosing Show Hide Buttons will make small arrows appear on either 

side of the panel so that you can click to slide it off the side of the screen when it’s not in 

use.  Both these two techniques create more desktop space.

You can also change the panel’s alignment to top, bottom, left, or right by changing the 

selection in the Orientation drop-down list. 

Adding and Removing Menus

You can add either just the Applications menu or the entire set of menus (Applications, 

Places, and System) to the panel at the bottom of the screen. This can help those who long 

for the Windows Start button approach to access programs.

Adding All the Menus to a Panel

To add the Application, Places, and System menus to the panel at the bottom of the Ubuntu 

desktop, follow these steps:

1. Right-click a blank spot on the bottom panel and select Add to Panel.

2. In the dialog box that appears, click the Menu Bar option to add all three menus. 

You’ll find this under the Utilities heading in the list; you’ll need to scroll down to 

see it.

3. Click the Add button at the bottom of the dialog box.

4. Click the Close button.

Adding a Start-Like Button to a Panel

As an alternative to the Applications, Places, and System menu, you can add a Start-like 

button that offers submenus for all three menus. See Figure 10-15 for an example. Here’s 

how to add this button:
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Figure 10-15. If you just can’t do without that Start button, you can re-create one on your 

Ubuntu desktop.

1. Right-click a blank spot on the bottom panel and select Add to Panel.

2. In the dialog box that appears, click the Main Menu option. You’ll find this under 

the Utilities heading in the list; you’ll need to scroll down to see it.

3. Click the Add button at the bottom of the dialog box.

4. Click the Close button.

Deleting a Menu

Creating new instances of the menus won’t delete the old ones. If you create a new Appli-

cations menu at the bottom of the screen, for example, the old Applications menu will 

remain at the top of the screen. In fact, you can have as many instances of the menus on 

the desktop as you wish, although this won’t be a good use of desktop space!

To delete any menu, simply right-click anywhere on that menu and select Remove 

from Panel.

■Tip  You can personalize the Applications and System menus by right-clicking either and selecting Edit 

Menus. This will start the Main Menu program (also accessible from the System ➤ Preferences menu). Simply 

check or uncheck existing entries to add or remove them from the menus, or click the New Item button to 

create new entries. 
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Moving Panel Items

To move a panel item, right-click it and select Move. Then drag the mouse to the new 

location, and click the mouse button once to set it in place. All panel items can be moved, 

including menus, and items can be moved between different panels. Any item that’s in 

the way will be shifted to make space.

If the Move option is grayed out, right-click it and ensure that Lock to Panel doesn’t 

have a check alongside it. This is especially relevant if you’re trying to move an item into 

the space occupied by something else—if the other item is locked, it won’t automatically 

shift out of the way!

GIVE ME MY TRASH CAN!

The developers who designed Ubuntu’s desktop decided to keep the desktop largely clean of icons. This 

included relegating the Trash icon to its own applet at the bottom-right side of the screen. Many people 

find using the applet a little difficult and miss the desktop trash can icon, which has been present on 

Windows and Mac OS desktops for more than 20 years.

The good news is that it’s easy to get the trash can back. Click Applications ➤ Accessories ➤ 

Terminal, and at the command prompt type gconf-editor. In the program window that appears, click 

the down arrows next to Apps, then Nautilus (you’ll need to scroll down the list a little), and then click 

Desktop. On the right side of the program window, put a check in the trash_icon_visible entry. The 

Trash icon should then instantly appear on your desktop! To delete the old Trash icon at the bottom right, 

simply right-click it and select Remove from Panel.

You can also put a check in the computer_icon_visible, home_icon_visible, and 

documents_icon_visible entries if you wish to see Computer, Home, and Documents desktop icons. By 

putting a check alongside network_icon_visible, you can add a My Network Places–style icon to 

the desktop, too.

Be careful when using the Configuration Editor program. It lets you configure just about every aspect of 

the GNOME desktop and doesn’t warn you when you’re about to do something devastating, so the potential 

for accidental damage is high! 

Working with Applets

Almost everything you see on the desktop is actually considered by the GNOME desktop 

to be an applet, with the exception of application/file icons and the panels. A menu is a 

form of applet, for example, as is the Workspace Switcher.
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■Note  Applets are completely separate from screenlets, which were discussed earlier in this chapter. 

Applets are built into the GNOME desktop to provide essential functionality. Screenlets are provided by the 

Screenlets subsystem and “float” on top of the desktop. However, there are often overlaps in terms of the 

functions offered by applets and screenlets. 

Ubuntu provides many more applets that you can choose to add to the desktop to provide 

a host of useful or entertaining functionality. To add an applet, right-click a blank spot on 

a panel and select Add to Panel. As shown in Figure 10-16, you have a wide choice of applets. 

Some require configuration when they’re added, so you may need to right-click them and 

select Properties. For example, you’ll need to set your location in the Weather Report applet’s 

properties so it can provide accurate forecasting. For more details about each applet, and 

whether it needs additional configuration, see Table 10-1. To remove an applet, simply 

right-click it and select Remove from Panel.

Figure 10-16. A wide variety of applets are available. Some are informative; others are just fun.
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Table 10-1. Ubuntu Desktop Applets

Applet Description Configurationa

Address Book Search Lets you quickly retrieve contact 
information from your Evolution 
address book.

None needed.

Battery Charge Monitor Shows the battery level on 
notebooks and whether outlet 
power is in use.

None needed.

Brightness Allows you to adjust the brightness 
of a laptop screen.

None needed.

Character Palette Displays a palette of accented or 
unusual characters; click a character 
to insert it into the text.

None needed.

Clipboard Text 
Encryption

Allows you to decrypt, encrypt, or 
sign contents of the clipboard, 
provided encryption is set up (see 
Chapter 9).

Click to encrypt, sign, decrypt, or verify 
clipboard contents.

Clock Displays the time and date (active 
by default).

None needed.

Connect to Server Lets you quickly connect to 
remote servers, such as FTP 
(equivalent of clicking Places ➤ 
Connect to Server).

None needed.

CPU Frequency 
Scaling Monitor

Shows CPU frequency and, on 
compatible hardware and if 
correctly configured (see Chapter 8), 
lets you change CPU frequency.

Right-click to change frequency.

Deskbar Adds a quick search text box that 
allows you to search the Ubuntu 
software library or the Web.

None needed.

Dictionary Look up Displays a text box that will look 
up words according to online 
dictionaries.

None needed.

Disk Mounter Lets you quickly mount and 
unmount removable disks.

None needed.

Drawer Displays a drawer icon that, when 
clicked, “slides out” to reveal yet 
more applets.

Right-click and click Add to Drawer to 
add applets.

Dwell Click Displays a selection of mouse 
actions to choose from for the 
dwell click feature (see the 
“Accessibility Settings” section 
earlier in this chapter).

Click the preferred mouse action. 
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Eyes Displays two eyes whose pupils 
follow the mouse cursor.

None needed.

Fish Adds a couple of fish to the panel 
that, when clicked, will spout 
wisdom.

None needed.

Force Quit Lets you quit a crashed program. None needed.

Invest Adds a text-based scrolling stock 
ticker to the panel.

Right-click and select Preferences to 
add individual stock symbols to the list.

Inhibit Applet Allows you to temporarily switch 
off automatic power saving, such as 
hard disk spin-down.

Click to forbid/allow automatic 
power saving.

Keyboard Accessibility 
Status

Shows whether sticky keys or other 
accessibility functions are activated.

None needed.

Keyboard Indicator Shows the current language settings 
of the keyboard.

None needed.

Lock Screen Adds an icon that, when clicked, 
blanks the screen and displays a 
password prompt.

None needed.

Main Menu Lets you add a single icon 
Start-like system menu.

None needed.

Menu Bar Adds a new Applications, 
Places, and Desktop menu bar 
to the panel.

None needed.

Modem Monitor Displays virtual LEDs showing 
when modem data is sent/received 
and lets you quickly dial up with a 
single click.

None needed.

Network Monitor Displays virtual LEDs showing 
data sent/received via networking 
devices.

None needed.

Notification Area Adds a notification area to the 
panel (active by default).

None needed.

Pilot Applet Lets you quickly connect to Palm 
devices via Gnome-Pilot software.

If Gnome-Pilot hasn’t already been 
set up, a configuration dialog box will 
appear.

Pointer Capture Lets you temporarily switch off the 
mouse pointer, to prevent mouse 
movement from getting in the way 
of typing.

Point the mouse cursor to the Pointer 
Capture icon (a green bar) and click to 
lock the mouse pointer. Click again to 
release the mouse pointer.

Quit Lets you log out or shut down. None needed.

Table 10-1. Ubuntu Desktop Applets (Continued)

Applet Description Configurationa
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a Nearly all applets have configuration options that can be used to tweak them in various ways. This column 
indicates only if immediate configuration is needed.

Run Application Adds an icon that, when clicked, 
makes the Run Application dialog 
box appear. 

None needed.

Search for Files Provides one-click access to 
Nautilus’s search mode.

None needed.

Separator Simply inserts a graphical 
separator—useful for making 
several applets alongside each 
other look neater.

None needed.

Show Desktop Minimizes all desktop windows 
(active by default).

None needed.

Sticky Notes Lets you create virtual sticky notes. None needed.

System Monitor Adds a small graph that shows 
system resource usage.

Right-click and select Preferences to 
choose system areas to be monitored.

Terminal Server 
Client Applet

Provides one-click access to 
locations set up within the 
Terminal Server program (see 
Chapter 33).

None needed.

Tomboy Notes Lets you add sticky notes to 
the desktop.

None needed.

Trash Adds the Trash icon to the panel, 
where files can be dropped for 
removal to Trash.

None needed.

User Switcher Adds an icon that, when clicked, 
allows you to switch to another user.

None needed.

Volume Control Adds volume controls (active 
by default).

None needed.

Weather Report Adds an icon that shows current 
weather conditions.

Right-click, and select Preferences 
and then the Location tab to set your 
location.

Window List Adds a list of windows, which 
you can use to switch between 
currently running programs 
(active by default). 

None needed.

Window Selector Adds an icon that, when 
clicked, switches between 
currently open windows 
(alternative to Window List).

None needed.

Workspace Switcher Shows virtual desktop selector. None needed.

Table 10-1. Ubuntu Desktop Applets (Continued)

Applet Description Configurationa
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Summary
In this chapter, you’ve learned how to completely personalize Ubuntu to your own tastes. 

We’ve looked at changing the theme so that the desktop has a new appearance, and we’ve 

examined how to make the input devices behave exactly as you would like.

In addition, you’ve learned how to add and remove applets from the desktop in order 

to add functionality or simply make Ubuntu work the way you would like.

In the next chapter, we will look at what programs are available under Ubuntu to replace 

those Windows favorites you might miss.


